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Enabling Collaboration with Blogger

Why Blogger?
We recommend that courses looking to incorporate a blog element use Google’s Blogger service for a

couple of reasons:

* Most students already have a Gmail account and therefore, already have access to Blogger. This limits
the amount of students who will need to create yet another account for a class project.

* Blogger is powerful and versatile enough to do just about everything a student will need to do, but is
easy enough to learn proficiently with one workshop. This means that students can spend more time
learning the course material and less time learning the technology.

What does Blogger require?
* An internet connection and a browser (Internet Explorer, Firefox, Safari, etc.)
* A Blogger or Gmail account

Blogger Features

* Embed images, video, or widgets (also known as “Google Gadgets”™)
e Full word processing (“WYSIWYG”) editor (including spell check!)
e Multiple authors on a single blog

e Multiple blogs to any account

* Privacy settings

e Ability to moderate comments

* Scheduled posting

* Mobile blogging

e Customizable layout and template
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go to www.blogger.com and
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Create a blog. It’s free. ( )

It's easy, and only takes a minute.

Your blog. Share your thoughts, photos, and
more with your friends and the world. Learn more:

Take a quick tour
Watch a video tutorial

@ Easy to use. It’s easy to post text, photos, and Discover more features

When your account has been
created, click on the link to
“Create a Blog.”

videos from the web or your mobile phone. Read Blogger Buzz

Blogs of Note

The rest of this handout will
walk you through setting up,
designing and posting to your
new blog.

Flexible. unlimited flexibility to personalize Julie Magers Soulen Photography
your blog with themes, gadgets, and more.

Home | Features | About | Buzz | Help | Discuss | Language | Developers | Gear
Terms of Service | Privacy | Content Policy | Copyright © 1999 - 2009 Google
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Create your blog.

Give your blog a name and a URL. These do not have to be the same and you can change both the title
and URL anytime that you like after the blog has been created. Click the “Check Availability” link to find
out if your preferred URL is available or not. Complete the security measure and press “Continue.”

NAME BLOG

Name your blog

Blog title

ququququ

Blog address (URL) http:/ /] -blogspot.com

Word Verification

Choose a template. Blogger offers several templates (most of which have “subtemplates” with different
color schemes). You can change the template at any time. You can also adjust the color of every element
in your blog theme if you choose. At this point, you just want to pick a theme to start with and press
“Continue.” The section on the “Layout” options will show you how to change themes, colors, fonts and
how to upload different themes from the web.

NAME BLOG CHOOSE TEMPLATE

) Choose a template

At this point, you’re done with the basic creation of your blog. Click “Start
Blogging” and you will be taken to an empty posting screen. You can begin writing or alter your blog’s
settings or design.

Your blog has been created!

We've just created a blog for you. You can now add your posts to it, create your personal

profile, or customize how your blog looks.

» Advanced Setup Options
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The Postine Tab B 1 GA Teaching Through the Flu Sample Blog

Settings Monetize Yiew Blog

The posting tab is where you can create and edit posts and modeate comments, if you so choose.

New Post

8 LSA Teaching Through the Flu Sample Blog

Posting Settings Layout Monetize View Blog

Mew Post | Edit Posts Comment Moderation

Title: ‘WE|EDI‘I‘IE!

Edit HTML | | Compose

WYSIWYG Editor_ |

This blog will help you learn how to use Blogger to create, design and populate a blog for your
course. Blogs can help increase communication and participation in your course...even for
those who are not physically present,

» Post Options Labels: | bleg, communication
Reader comments Post date and time

= Allow (=) Automatic

O Don't allow O Scheduled at
Edit HTML Settings Compose Settings

= Convert newlines to <be />% = Interpret typed HTML

) lgnore newlines ) Show HTML literally

Draft saved at 9:56 AM

Above the actual post content, you can see what’s called a “WYSIWYG” (pronounced wizzy-wig) editor.
This is a basic word processing editor that’s fairly common in a lot of online applications. The WYSIWYG
editor gives you most of the basic tools you will find in Microsoft Word.

For each post, you can also choose whether or not to allow reader comments and whether the post will be

published immediately or at a scheduled date and time. If you want to keep this post as a draft to work on
later, click “Save.” If you are ready to publish immediately, click “Publish Post.”
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How do I embed an image?

Click the image icon in the WYSIWYG editor.

& LSA Teaching Through the Flu Sample Blog

Settings Monetize View Blog

Mew Post | Edit Posts CU'%HL Moderation

Title: |WE|cnmE!

Preview | Edit HTML | | Compose

- f'ﬂ'-lf*-“£-:‘-m===|E;5n14

This blog will help vou learn how to use Blogger to create, design and populate a blog for vour
course. Blogs can help increase communication and participation in vour course...even for
those who are not physically present.

This will open a dialog box with two options: upload an image from your computer or submit a link to an
image you found online.

To upload an image, click the “Browse” button, find and select the image on your computer and click “Ok.”

Add an Image

= Uploaded images Upload an image

) Web address (URL)

Ok Cancel

To embed an image you found online by linking to it, paste the URL, or web address, of the image into the
box and click “Ok.”

Add an Image

image URL | "R

) o

D Uploaded images

If wowr URL is correct, you'll see an i rere. Large images may take a

= Web address (URL)

few mir

Remember: Using athers’ images on the web without their permission may be bad manners, o worse,

comyright infringement.
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To change the size or alightment of the image once it has appeared inside your posting window, click on the
image. An image tool bar will pop up at the bottom.

Title: | How to embed an image
Preview Edit HTML Compose

e F=1T~ B J a0 A~ S Link o2 E E 83 B |E = w L

, V
| MICHIGAN _
Vi

Small - Medium - Large - Onginal size | Left - Center - Right | Remove

Showr all

o

» Post Options Labels:

Return to list of posts

Here you can choose to make the image small, medium and large, as well as change the alignment, or remove
it all together.

Just a note: in Firefox, it is possible to double click on the image and manipulate its size by pulling on the
“handles” that appear around the edges. This is not generally possible in Safari or Internet Explorer.

To get an idea of how your image will look inside your post, click “Preview.” Be aware that your alignment,
image size and the size of your posting space as dictated by your theme can affect how images and text are
placed once the post is published. You may have to tweak things a bit here and there to get your desired ef-
fect.

How to embed an image

@

POSTED BY LAUREN ATKINS AT 8:09 AM 'f;

For those who know HTML, you can click on the “Edit HTML” tab and insert images there as well. How-
ever, we do not recommend this for users who are not comfortable with using HTML code.
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How do I embed video?
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Blog authors can embed video from YouTube very easily. First, go to www.youtube.com and find the video
you would like to embed.

Select the embed code for that video.

The embed code can be found on the right side of the
video’s page, next to the name of the poster, the video’s
description and the URL. You want to make sure

to grab the embed code, NOT the URL. The embed
code is a long string of HTML code that will nestle a
video player inside your post, so that readers can view Embed  <object width="425" height="344"><param nz |#F
it from within your blog, instead of linking out to

YouTube.

chesh1recat
August 24, 2009
(more info)

back of the couch

Subscribe:

Winston trying to get his toy.. by jumping over the

\ URL http=ifweww. youlube.comfwatch Pw=tFuHTCo_f

Click on the code and copy it. It should be a short paragraph of code; if you insert just the URL or a fragment
of the code, it will not work.

Go back to your posting window and paste the entire block of code directly into your post.

Title: | How 1o embed a video from YouTube

Preview Edit HTML Compose

. F~1T~ B & s A~ S- Link oz BFEE B E | = 8 L 3

Make sure that you grab the embed code, not the link. If the code is short, then it will not
work. If no embed code is offered, then the person who has posted the video has opted not

to allow anyone to embed it.

Just paste the entire code directly into your posting window. To see how it looks and plays,

click "Preview.” When you're all set, you can publish the post.

type="application /x-g

<object width="425" height="344"><param name="movie" value="http: / / www.youtube.com
v [ tFuHTCe_Fid&hl=enéfs=1&">< [ param><param name="allowF Je¥
value="true"></param=><param name="allowscriptaccess” value="always"></param=
<embed sre="http:/ / www.youtube.com /v /tFullTCc_Fid&hl=ené:fs=1&"

ackwave-flash” allowscriptaccess="always" allowfullscreen="true"
width="425" height="344">< / embed >< / object>

ullScreen”

b Post Options

PUELISH POST
Return to list of posts

Labels: |1:m bed.

Wideo

To see how your video looks, click the “Preview” button. If you are satisfied with your post, you can Save or

Publish it.

Using Blogger

THURSDAY, SEPTEMBER 17, 2009
How to embed a video from YouTube

Make sure that you grab the embed code, not the link. If
the code is short, then it will not work. If no embed code is
offered, then the person who has posted the video has
opted not to allow anyone to embed it.

Just paste the entire code directly into your posting
window. To see how it looks and plays, click "Preview."
When you're all set, you can publish the post.

winston ve the couch

@ 0:00/1:42 | et | | €3

POSTED BY LAUREN ATKINS AT 8:14 AM O COMMENTS &7
LABELS: EMBED, VIDEO

LSA INSTRUCTIONAL
SUPPORT SERVICES

If you ever encountered an
instructional challenge in your
teaching or wondered if
technology might help you to
enhance your students’
learning, ISS Instructional
Technology Consulting can
help you. Enhancing student
learning through the use of
instructional technology is
central to the ISS Instructional
Technology team. Consultants
are eager to explore, plan and
work with faculty to fulfill
learning objectives on

ional technology

Contact us with questions,
concerns, or to schedule a
consultation or workshop
at:

issinstruction@umich.edu
734-615-0099
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Edit Posts

Perhaps you have saved some posts as drafts, or you’d like to go back and edit previously published posts. To
do that, go to the “Edit Posts” link under the Posting tab.

MewPost | EditPosts | Comment Moderation

m Posts Per Page M

Your Posts: All, Drafts, Scheduled, Imported, Published -30f3

Label Actions... + | Select: All, None

[ Edit View » How to embed a video from YouTube smseq, Video 8:14:00 AM by Lauren Atkins  Delete

communication (1)
communication 8:09:00 AW by Lauren Atkins Delete

embed (1
VYideo (1

O Edit View » How to embed an image

6:57:00 AW by Lauren Atkins Delete

O Edit View » Welcome! b, communication
1-30f3

| pusuisi sevecrep | peeTe seecteo |

In this screen, you can edit, view or delete any of your posts, or filter them by such criteria as Published,
Scheduled, Drafts, label (tag), etc.

Moderate Comments

Comment moderation means that you, as the blog’s administrator, have decided that no reader’s comments
will be displayed on the blog until you have approved them. This feature can be turned on in the “Com-
ments” section of the “Settings” tab.

Comment moderation
14  days

dashboard wien there are comments to review. Learn more

Email address

We will email you at this address when a non-member Lleaves a comment an
wour blog. Leawve blank if you don’t want to receive these emails.

Show word wverification for comments? = Yes O Mo

This will require people leaving comments on your blog to complete a word
verification step, which will help reduce comment spam. Learn more

Blog authars will not see ward verification for comments.

If you choose to turn on this function, Blogger will save all received reader comments in a list for you to
review. You can choose to publish or reject them as you see fit.

-

Unreviewed Comments (Sort: Post Name, Comment Date) Comments per page: |50

Select: All Mone

[ 5, Is it time for tea yet? (Arthur Dent) 12:07 PM
% Publish Reject

I » hi (kimmy) 11:13 AM

Select: All None
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. B LSA Teaching Through the Flu Sample Blog
A — Posting Settings Layout Monetize View Blog
—_

The Settings tab gives you control over a variety of publishing options for your blog. We will only cover a
portion of the options available, as many will most likely not be changed from their default status by users.

Basic Tools

This includes the ability to import, export or delete your blog, as well as alter the title and description.

For those who want to keep their blogs private, we suggest you opt “No” for the options “Add your blog to
our listings” and “Let search engines find your blog.”

Add your blog to our listings?

A Listed blok may be linked to from Blogger.com, such as the Blogger home
page, Bloggek Play, and Mext Blog. If you select "No" your blog will not appear

Let search engines find your blog?

you sptfect “es™ we will include your blog in Google Blog Search and ping

Weblogs.com. If you select "No™, everyone can still view your blog but search
engines will be instructed not to crawl it.

For the most efficient use of your blog, you’ll also want to opt for the “Updated” posting editor. Authors of
language-related blogs may be interested in enabling the “Transliteration” feature, which adds a button to
the toolbar for converting words from English to a selected language. Corrections you might make to the
translations are saved and used by Google to help improve the tool.

Global Settings  (Applies to all of your blogs.)

Select post editor ® Updated editor
O Old editor

0 Hide composea

heck out the (atest features!

Ade - Select only if you typically do HTML editing instead of WYSIWYG text editing.

Enable transliteration? Disable _* ||in | Hindi - fe=r j Learn more

Adds a button to the toolbar for converting words from English to the
selected language. (You may later change the language in the Post Editor).
Your transliteration corrections will be saved to help Google improve this
tool. See Privacy Policy for details.

Remember to “Save Settings” after making any adjustments.

Publishing
Use this menu to change the URL of your blog if you desire, or if you’d like to move your blog to a custom
domain name.

Formatting
This menu allows you to adjust the appearance of the date and timestamp format, as well as the language, of
your blog.

Comments

This menu, obviously, dictates whether comments will be shown, who can comment, where the comment
form will be and whether you will be moderating comments. For more privacy, users can opt to make com-
menting available only to Google Accounts or Members (i.e., authors and admins) of the blog. Limiting
commenting ability in conjunction with limiting blog access will shield you from spam and unwanted
readers.
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Archiving
This menu deals with the frequency at which your blog posts will be archived.

Site Feed

Allows you to adjust the syndication feeds of your blog. Syndication feeds, or RSS feeds, are what enable
your blog content to be pushed out to readers. RSS feeds are one of the bonuses of using a blog format over
a traditional website.

Email & Mobile

You can opt to send an emal to specific addresses whenever a new post is added to the blog (generally un-
necessary, particularly if readers subscribe to the RSS feed), as well as choose an email address by which to
publish blog posts remotely. This means that instead of visiting blogger.com each time you want to publish
a post, you can email content in from any internet-capable computer or smart phone.

OpenlD
Lets you adjust OpenlD settings. For more information on OpenID and what it means, visit

http://openid.net/

Permissions
This section is very important, particularly for those wanting to selectively share their blogs.

This menu allows you to add other authors to your blog by inserting their email addresses.

Q Blog Authors vour blog can have up to 100 authors.

1 Author can post to this blog

officethemondss pesbirgcat@gmail.com admin
Invite more people to write to your blog

Choose from contacts
Enter the email addresses of people you want to write to your blog (separated by commas)

You can also limit who can read your blog: anyone, only blog authors, or only people you choose. For
private class blogs, the “only people I choose” option tends to be the best. Select that option and enter in the
email addresses of your intended readers; they will receive an emailed invitation to view your blog with their
own Blogger or Gmail accounts.

ia Blog Readers our blog can have up to 100 readers.

Who can view this blog?
D Anybody = Only people | choose ) Only blog authors

Invite some people to read your blog

Choose from contacts
Separate email addresses with commas. Blog authors already hawve access.

WITI
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The LaVOut Tab 8 LSA Teaching Through the Flu Sample Blog

Posting Settings Layout |) Monetize ‘View Blog

The Layout tab allows you to switch or upload templates, and alter the colors and fonts of your templates.

Page Elements

In this section, you can edit, add, delete and move around the various modules of your blog template. Not all
elements can be moved; just the darker shaded ones. To move them, click and drag them around the space and
position them in the place you want them to be.

Add and Arrange Page Elements
Click and drag to rearrange page elements on your blos. m m
. e Edit

LSA Teaching Through the Fl...

Blog Posts . ________ Adda aa:d_g_c_l. ________ ‘
Followers
]
Moveable
Unmoveable Blog Archive "
About Me

You can also add Google Gadgets to your page. Gadgets, or widgets, are little snippets of HTML code that you
can use to add various elements to your page, such as calendars, text, RSS feeds, or even hooks into your Twit-
ter or Flickr account.

To add a gadget, click on the “Add a Gadget” link. A dialog box will pop up. You can search or browse for a
gadget you’d like to add. When you’ve found one, click the plus sign next to it to add it to your page. If you
choose a gadget that connects to another account of yours, such as Twitter or Flickr, it will ask you for your user
ID for that service.

8 Add a Gadget

Featured [tsearch for gadgess | (Y

1-100f 10

Event
Use this gadget to promote an event on your Blogger.com blog. Members of your blog can get det?

about the event, see a map, indicate whether they will attend, and see whe else has responded. Events
can be added 1o a member's Google Calendar with a single click.
By Google

SocialVibe
The Social¥ibe widget allows you 1o get sponsored by a paying brand and earn donations for the charity
of your choice.

By SocialVibe

Flickr n
Display thumbnails of your most recent Flickr photss
By Blogger Buster

Share it
Allow users Lo share or bookmark your website pages on their favorite social networks and social
bookmarking sites.

By Barry Welch

Recent Posts
Show your most recent posts, with aptional summaries
By Blogger Buster

Twitter Updates
4% Twikter | share your recent Twitter updates
L updates | oy slogger Buster
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Fonts and Colors

Once you have chosen a template, you can adjust all the colors within that template. To do so, click on any col-
or element (such as Page Background Color, Blog Title Color, etc) and then click on a color swatch to change
its color. Blogger will give you a preview of your changes in the window below the color palette. If you want

to save, click “Save Changes.” If you aren’t happy with the changes you’ve made, click “Clear Edits” and your
template will revert back.

I— Page Baciground Color Choose a color for Page Background Color
— L Colers frem your blog More colors Ed Jor hex cod
I et color ANENE HEEEEEEE o coorhexcode
— Colors that match your blog SEEENENNN sooofif
I Link Color 1 EEE EE INNNNEEEE
—_— Rewert to template default
B stog Ti ;| EEEEREEEEE iSSEEEEEE
Blog Title Color L EEEEEERE :rufile blog colors

Edit HTML

This section allows you to directly alter the HTML code of your template. We do not recommend this to any
user who is not already familiar with using HTML. You can also upload a template here that either you have
created yourself, or that you’ve downloaded from the internet. When downloading a template from online, you
want to make sure to use the .xml file that should come in the download package. Keep in mind that occasion-

ally you may find a template that does not work. Uploading a template does not erase or change any of your
actual posts; just the design of the blog.

Backup / Restore Template

Before editing your template, you may want to save a copy of it. Download Full Template

Upload a template from a file on your hard drive: ( Browse... ) [ Upload )

When you are all set, take a look at your blog and see what you’ve done. You can always go back and create
more posts or make style changes using the toolbar at the top of the window:

cheshirecat@gmail.com | New Post | Customize | Sign Out

Questions?
Lauren Atkins
LSA Instructional Support Services
Instructional Consulting
G333 Mason Hall
latkins@umich.edu
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